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Preparations 
For that effect Mr. Aibéo used the ASF Fund still remaining 
from 2013 and allied itself to the Electricity Festival organized 
by LeSPACE4 and as an event by the renowned Helsinki 
Design Week5. The workshop involved a fee for non-Aalto 
students to cover extra costs related to food during the 
workshop.  

Prior to the event, a new website6, a joint scheduling tool7 
and advertising through printed flyers and posters was done 
and a total of 17 people attended the 2 day workshop along 
with several other Professors and Professionals who came 
over to meet the experts. The current direct link to the 
workshop: http://www.aibeo.com/#!workshops/cvz7  

The Workshop 

Arrival 
Upon arrival, the guests were taken to their 
accommodations and were handed a schedule 
draft, flyers and a briefing on the upcoming 
meetings and on the workshop. 

Content 
The workshop was advertised on the web with 
the following explanation text (also in Finnish): 
“Learn how to make an interactive 3D model of 
the rooms of your house with your own photo 
camera. A hands-on, two day workshop, with 
experts from Germany, Portugal and Finland, in a 

relaxed environment.  On a two day workshop at LeSPACE, we invite everyone above the age of 8 to 
learn how to take photos of their home and turn them into an interactive 3D model. These new 3D 
models will be placed online, in an online map, so you can share them with your friends. They will 
allow interaction with the 3D objects you created.  Bring your own laptop with wi-fi connection and a 
camera (also mobile phone camera possible). Participants should know how to use a computer and 
take photos! This workshop is part of the international research on “Architectural Democracy” based 
at Aalto University. Our team believes we can use the rooms where we spend most of our lives, as 
sources of open source information to edit and share among citizens for community well-being. Not 
only is this a tool to create time machines to understand the history of our cities but to understand its 
economics, technicalities and social relationships, for a fairer society based on transparency. The 
course is held mainly in English but Finnish is also available. Please contact us in English.” 

                                                            
4 http://www.lespace.fi/index.php?page=productions 
5 2015’s theme of the design week was the ”Time Machine”: focused on cities and their future. ttp://www.helsinkidesignweek.com/?lang=en 
6 http://architecturaldemocracy.com/ 
7 https://www.smartsheet.com/ 

Fig. 3. Workshop’s flyer and poster. Prof. 
Falcão was firstly publicized only for 
internal meetings. 

Fig. 4. The briefing included information of the persons and 
institutions to meet. 



 
 

Everyone above the age of 8 and both 
experts as well as amateurs was welcomed. 
The target group was software developers, 
designers, urban innovators, game 
designers and architects. Also, to save 
valuable time, the participants who 
subscribed to the event were adverted to 
install the following software on their 
computer in advance and to bring both 
laptop and smartphone along: 

-        Unity 5.1 Personal Edition  
-        Autodesk 3ds Max 2016 30-day-Trial  
-        123D Catch     
-        Visual SFM 
-        Meshlab     

The workshop initiated with an introduction from Mr. Aibéo explaining the schedule and introducing 
the speakers:  “We'll use the first session to introduce 3d scanning concepts and for tackling issues 
concerning photo capture. Between the two sessions each one makes his own photo capture (at 
home, work, street). In session 2 we'll build models from the photos each one took using on-line 
processing (123D Catch) and learn how to edit them in a 3D editor (MeshLab). During the two 
sessions we'll use Visual SFM to explain how the photogrammetric engine works because with 123D 
catch you don't see anything of what's going on. By the end of workshop, participants will know how 
to build simple 3d models from photos and how to edit them. As a final task, the models can be 
uploaded in sketchfab and be available for everyone.”  

On the first day, there was an introduction to photogrammetry and on interaction (framed around 
unity) followed by software installation and work assignments. The second day was more focused on 
helping the participants with their difficulties and questions: 

Saturday 9:00 – 12:30 
Welcoming by Pedro Aibéo 
Introduction to photogrammetry and tools (Mr. Pires) 
Hands-On with photo shooting (Mr. Pires) 
Introduction to interactive scene creation (Prof. Kruse) 
Software Installation 
Home task for participants:  
 Photo shooting of one or two (connected) rooms 
 Upload photos to Autodesk 123D Catch 
 Download generated 3D-Model 
 Import and optimize data in Meshlab 

 

Fig. 5. First moments of the workshop 



 
 

Sunday 14:00 – 17:00 
Prof. Falcão presentation & discussion 
Check generated 3D-Data (Mr. Pires) 
Step-by-step walkthrough for creating 
interactive scene (Prof. Kruse) 

Mr Pires’ Presentation 
Mr. Pires is a photogrammetrist with vast field 
experience in geomatics. He has developed the 
technology of MRM (Morphological Residual 
Modelling) where formerly untraceable 
archeological remains are now readable. Such 
groundbreaking approach has deepened his 
involvement into academics where he is now 
mostly active. He is an invited author of the 
National Geographic Magazine and some of his 
articles include the “Morphological Residual 
Model. A Tool For Enhancing Epigraphic 
Readings Of Highly Erosioned Surfaces” or the 
“From point clouds to archaeological evidence: 
Improving visualization and spatial analysis of 
3D data”8  

Mr. Pires’ presentation introduced firstly the 
joint work done with Pedro Aibéo in Porto 
which explained the principle of parallaxe, a 
fundamental one to photogrammetry. It 
followed the tests done in Helsinki in 2014 at 
the Marmori Palatsi, Viipurinkatu, the Arabia 
Campus and Mannerheim Museum. At 
Marmori the low lighting conditions and the 
homogeny surfaces (with low contrast) of the 
indoors were rather challenging to create a 
good 3D model. At Viipurinkatu, Mr. Pires 
showed the embedding of the newly created 
3D models of a residential building into an 
online map. At the end of the presentation Mr. 
Pires introduced the free software9 to be used 
during the workshop and facilitated its 
installation among the participants. 

 

  

                                                            
8 Further publications can be read here: https://independent.academia.edu/hugopires 
9 mainly being 123Dcatch and Visual SFM 

 

Fig. 6. Mr. Pires’ presentation at LeSPACE in Helsinki 2015 

 

Fig. 7. Mr Pires supporting the participants which were of very 
different ages and backgrounds 

 

Fig. 8. Mr. Pires’ presentation included the process of generation of 
3D models from photos based on paralaxe 



 
 

Prof Kruse’s presentation 
Prof. Kruse currently teaches Interactive 
Media Design at the Erfurt University of 
Applied Sciences (FHE). He has an extensive 
practical experience with Institutions such as 
the European Space Agency or the 
Fraunhofer Institute. He has been doing 
much work around virtual reality including 
the development of a low budget virtual 
reality system for a theater play at the 
Darmstadt’s State Theater which was later 
acquired by Siemens AG. This theater play 
was the first interaction with Prof. Kruse and 
Mr. Aibéo, back in 2007. His background in 
Architecture (Dipl. Ing.) and his flexibility in 
finding low key solutions for complex 
problems are fundamental for this joint 
work. 

Prof. Kruse presentation focused on the 
usage of unity 5. Picking up the first example 
of Mr. Pires, the house of caldeireiros in 
Porto, he showed how to incorporate the 
point cloud model into unity 5 and then how 
to build up physical elements into it.10 

 Software requirements were Unity 4.6 (free) 
or newer. At the workshop one used the 
version 5.2 Personal Edition (or Pro) on 
Windows with the additionally standard 
assets. No advanced features which involved 
programming (in C#) were needed during 
this workshop. 

Prof. Falcão’s presentation 
Prof. Gabriel Falcao carries out his research 
activity at Instituto de Telecomunicações and 
Department of Electrical and Computer 
Engineering, Faculty of Science and Technology of the University of Coimbra (FCTUC), Portugal. He 
currently investigates efficient parallelization techniques, algorithms and architectures for compute-
intensive signal processing applications (Ralha, 2015), as well as novel paradigms (Pratas, 2013) for 
achieving energy-efficient fast parallel computation (Falcao 2012, Owaida, 2015). 

Entitled “GPUs and parallel computing, towards 3D reconstruction“, Prof. Falcão presentation was 
divided into three parts:  

                                                            
10 the procedure can be found at attachment 1 - Interactive Scene step by step by Prof. Kruse 

 

Fig. 9. Prof. Kruse’s presentation  

 

Fig. 10. Prof. Falcão being guided by Prof. Kruse through a VR tour 
inside of one building at Porto. 

 

Fig. 11. Prof. Kruse clearing out technical doubts among the participants 



 
 

- The evolution of CPUs (from single to multi-core) 

- GPUs (Graphics Processing Units), a hardware 
designed for high parallel applications and which had a 
tremendous boost over the last years, mainly via the 
gaming industry.  

- Real-time 3D reconstruction based photo-symmetry 
(SymStereo - Dense) 

The buildup was necessary to understand the 
importance of parallel computing in order to create a 
real-time pipeline that generates realistic 3D volumes. 
The new algorithm generates 3D models automatically 
by recognizing geometries (plans) which are stored in 
a very compact form (as opposed to existing methods 
that are based on compute- and bandwidth-intensive 
point cloud systems), allowing rapid data transmission 
and volume construction (potential for 3D 
reconstruction in real-time has been identified). 
Furthermore, this approach has proven to be able to 
work with only a small number of images. The 
acquisition of pairs of images can be performed using 
conventional stereo cameras (< 300€) but it is also 
possible to use regular cameras (previously 
calibrated).11  

The Meetings 
During and around the workshop, the invited speakers 
met several experts in Helsinki: 

Meeting with Forum Virium 
The first day, the 25th, was reserved solely to meetings. The first one was set at 10:00 am at the 
“Factory” cafeteria in downtown Helsinki at Aleksanterikatu 13 with Hugo 
Goncalves (hugo.goncalves@forumvirium.fi) and Roope Ritvos  (roope.ritvos@forumvirium.fi) from Forum 
Virium.   

Forum Virium Helsinki is an innovation unit within the Helsinki City Group. It develops new digital 
services and urban innovations in cooperation with companies, the City of Helsinki, other public 
sector organizations, and Helsinki residents. The aim is to create better services and new business, 
plus to open up contacts for international markets.12  

There has had been former meetings with Mr. Aibéo and Forum Virium. They have shown great 
interest in the ideas and Modus operandi of “Architectural democracy” but despite many promises of 

                                                            
11 Pointers to some of these results of this lab can be seen here: https://developer.nvidia.com/academia/centers/university-coimbra 
http://home.isr.uc.pt/~jpbar/Videos/eccv2014.mp4 
http://home.isr.uc.pt/~jpbar/Publication_Source/eccv2014.pdf 
https://youtu.be/KrF8rsXuNOk 
12 Retrieved from http://www.forumvirium.fi/en 

 

Fig. 12. Prof. Falcão starting his presentation 

Fig. 13. Prof. Falcão’s last slide with many examples on their 
3D generative process 



 
 

collaboration, mainly through joint H2020 applications, all of these have fallen into oblivion. The 
main areas of interest of Forum Virium were on the side of energy conservation and the revitalization 
of public spaces. 

Meeting with Aalto’s BIM Initiative and Prof. Singh 
The BIM initiative seeks to directly engage in problem discovery and solution design with leading 
developers and adopters of BIM.13 The brief meeting with Prof. Singh and the invited researchers was 
held at LeSpace during the workshop. 

Prof. Singh was key to enable this workshop through his letters of invitation to both the University of 
Coimbra and University of Erfurt (see attachments). As supervisor of Mr. Aibéo’s doctoral research 
the meeting had the function of getting to know each other’s work and to establish a working plan. 
From the meeting it was clear that future collaborations will continue to take place in both practical 
and academic level.  

Meeting with Aija Staffans (ABE) and Liisa Horelli 
Aija Staffans is a Senior Researcher Fellow at YTK and has been developing ABE (Aalto Built 
Environment Laboratory), a cross-disciplinary research facility with an interactive modelling and 
visualization space at Aalto University.14  

Dr. Liisa Horelli is an Adjunct Professor and 
environmental psychologist who conducts research at 
Aalto University, on participatory e-planning and smart 
cities.15 

Both Aija and Liisa have been following Mr. Aibéo’s work 
and several common projects have come to fruition such 
as the 2015’s 3D City Model Hackathon. There is a 
common understanding of the importance of a Human-
centric living environment on the whole smart cites 
strategy. From the meeting it was realized that possible 
cooperation around the Otaniemi campus development 
is desirable. 

Meeting with Tietoa’s Project Manager 
Jaakko Hauru 
Tietoa is a Finnish company offering BIM- and 
visualisation services for building owners and 
developers, constructors, construction professionals and 
designers. “Tietoa” is a Finnish word for information and 
knowledge – the core of modern virtual building.16  

                                                            
13 Cf. https://wiki.aalto.fi/display/ABIM/Aalto+BIM+Initiative+Home 

14 Retrieved from  http://maa.aalto.fi/en/research/ytk/research/abe-2/ 

15 Cf. https://wiki.aalto.fi/display/Palco/Liisa+Horelli 
16 Cf. http://www.tietoa.fi/ 

 

Fig. 14. Prof. Falcão with Jaakko Hauru 



 
 

Jaakko Hauru is a project manager at Tietoa and has been collaborating with Mr. Aibéo since the 
2015’s presentation at Senaatti. (http://www.senaatti.fi/en). After conversations with Prof. Falcão 
and Mr. Aibéo, a short-term project was agreed, and currently Mr. Hauru and Mr. Aibéo are scanning 
the city of Helsinki with a new developed low budget stereo camera, in which Prof. Falcão is 
processing the data and turning it into 3D. 

Meeting with the 
Photogrammetry research Group 
of Aalto 
Representing the research group of 
Photogrammetry and Remote Sensing based 
at the department of Real Estate, Planning 
and Geoinformatics, was Petri Rönnholm 
and  Lehtola Ville, who met all the invited 
researchers at Iltava in downtown of 
Helsinki. In 2014, Petri Ronnholm conducted 
a short experiment on the usage of 
photogrammetry free software among his 
students for the course of “ENY-C2005 Geoinformation in Environmental Modeling: Photogrammetric 
3D modeling of indoors” with the support of Mr. Aibéo and Mr. Pires. (attachment 2: course 
description). The results of it were inconclusive. On the meeting of 2015, the research group showed 
special interest on the work of Prof. Falcão and on his new developed algorithm. No further plans 
were set. 

Internal Meetings 
In several occasions either in groups or all 
together, the researchers discussed with Mr. 
Aibéo pending and future projects. Among 
these: 

Collaboration with 3Decide:  

3Decide is a software company in Portugal, 
which has experimented with the idea of 
panorama photos around the caldeireiros 
building in Porto. Online version here: 
http://3decide.com/showcases/interactive-3d-
workshop/ 

3Decide uses aLIVE Vision, a Visual Information 
System that fuses user generated content (GPS 
Coords, 3D Models, 2D Drawings, 360º Photos, 
...) into ready to use interactive visual 
experiences solving major issues like easy 
sharing, information update, collaborative 
workflows, cross platform compatibility, etc. 

 

Fig. 15. Meeting at Istava Café, downtown Helsinki (Photo by Hugo 
Pires) 

 

Fig. 16. Snapshot of the trial. The 3D model of caldeireiros 

 

Fig. 17. Snapshot of the trial. Part of the panorama of caldeireiros 



 
 

The visual contents are stored in universal / open standards and can be created with an increasing 
number of SWs / HWs...The aim is to democratize the creation of immersive and meaningful visual 
experiences with a "Tell your story" attitude rather than just "dumping" multimedia content, 
facilitating deeper collaboration among specialties (3D, 2D, Photo, Copy Writing, Story Telling, ...), 
even remotely. 

The collaboration with UNAM Mexico and Wuhan Universities:  

Both Universities have been inviting Mr. Aibéo to teach around the topics of Architectural Democracy 
and to help their Departments developing further its Master and Doctoral programs. Ongoing are the 
possibility of repeating the same 3D workshop of buildings at their campuses by students. 

Possible cooperation with REACT  

A project of the MoBiVAP group (http://www.mobivap.eu/). They have been developing strong work 
on CityGML with a LoD of 4. 

Other discussions involved the continuation of the interactive façade idea for “Casa da Musica”, 
discussion on the Meetings in Brussels on “Innovating Cities with Nature and Culture” which gathered 
a great amount of people (mainly lobbyists) to promote contacts and build consortiums around city 
regeneration through heritage and innovation (an overbooked event!) and others. 

Other activities 
Along these days Mr. Aibéo organized informal events either for dinning or to visit exhibitions. 
Included in these was the opening of the Ai Wei Wei exhibition at HAM and grilling at Regatta Café. 
During these moments, the researchers got to know themselves much better and conjured good 
ideas to further the cooperation which are ongoing. One of such is the ongoing proposal for the 
“Casa da Musica”. 

Conclusion 
The workshop brought together several experts for the first time. The interaction amongst them and 
with others, either for meetings or during the workshop proved to be again a great working model. 
These are people passionate about their work who both feel the need to improve every detail of it 
and to disseminate it to others. 

Efforts will be done to repeat such workshops on the same model or in the formats of hackathons.   
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Interactive Scene, step by step  
by Prof. Kruse 
September 2015 

 

Open Unity and create a new 3D-Project 

Create 3 folders in Project: “Scenes”, “Scans”, “Scripts” 

Import Models: Drag one .obj plus the according .mtl- and .jpg-file simultaneously from windows explorer onto 
the “Scans”-folder in Unity …this will take some time because Unity splits he geometry into smaller pieces 

In the Hierarchy tab: Create a Container Object and rename it to “Room” (or “Building” or something meaningful 
to you) 

In the Project tab: Find the material(s) in the Materials-folder of your Scans-folder: For each material set 
the Shader to “Unlit/Texture” in the Inspector. The scanned room should now have a brighter appearance, that 
does not change if you alter the directional light in your scene. 

optional: Disable or remove the Directional Light in theHierarchy 

Add all your imported Prefabs (box icon in Scans-folder) to the scene by dragging them on the “Room”-object in 
the Hierarchy-tab 

Optional: Move all objects to the world center by setting the Position of each object in the Transform-component 
to the same desired values. 

Rotate each object facing upwards by setting the “X”-axis of the “Transform” to “270” 

Add a default cube as reference with GameObject > 3D Object > Cube. Its  default size is 1 x 1 x 1m. If your 
scanned scene has not the correct dimensions, resize it with the Scale tool. Click on the center of the scaling gizmo 
and drag to preserve proportions. 

Create planes to “walk” on 

Switch to Top View, disable Perspective. 

Select GameObject > 3D Object > Plane. 

Move the created plane in Y-direction to match the scanned ground floor. 

Scale it as large as you want the user to be able to walk. 

In the Inspector, disable the Mesh Renderer to make the plane invisible. 

Add more planes for other floors, if you have such. 

Create collision geometry to avoid walking through walls and objects 

Create an empty container object and rename it to “Collision”. 

Select GameObject > 3D Object > Cube to create a cube object . 

Drag it into the “Collision”-container, if it’s not already in there. 

Move and size the cube to fit a scanned wall or furniture. 

In the Inspector, disable the Mesh Renderer to make the cube invisible. 

Repeat this for all scanned objects, which you don’t want the user to walk through. 

Finally add 4 invisible cubes as fence along the edges of your ground plane. 

Add FirstPerson View 

Add some Standard Assets to the project: Select Project > Import Package > Characters. Repeat that for 
the Utility- and CrossPlatformInput-asset. 
If these packages are missing in the menu, download the Standard Assets-Package from the Unity-Website: Select 
your PLATFORM and then select „StandardAssets“ from ADDITIONAL DOWNLOADS. Install the 
downloaded package and restart Unity. 

Drag the “RigidBodyFPSController”-Prefab to theHierarchy and rename it to “Player” 

In the Scene view place it where you want the user to start his/her tour. 

Test by pressing the blue Play-button 

You should now be able to walk around the scene using the arrow keys and mouse. 
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A Xbox game controller could also be used for navigation. 

optional: Viewpoints 

Download Spawner.zip, extract and import the Spawner.cs-Script into the Scripts-folder in the Project tab. 

Create one empty object as container and rename it to Viewpoints. 

Attach the script by dragging it onto the Viewpoints-object . 

Add three empty objects into Viewpoints and give them a descriptive name. 

Position them at a location you want the user to be placed to. 

Select the Viewpoints-object and drag its three subobjects to the according slots in the Inspector. 

You now can „teleport“ to those locations by clicking keys „1“, „2“ or „3“…or buttons on the gamepad. 

Export as standalone programm (Executable) 

Click in File > Build Settings… and check if the selectedPlatform is „PC, Max & Linux Standalone“. If not, then 
select this option and click on Switch Platform. 

Add your scene by clicking on Add Current. 

After clicking on Build and Run, you will be asked for a file name. 

Unity compiles the scene into a runtime executable and will start it. 
This executable (.exe) plus a directory (with the same name plus „_data“) can be used to view the scene without 
having Unity installed. 

If yout want to export to other platforms (Android, iOS, …) several preparations may have to be executed. Please 
have a look at the according Unity website. 
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ENY‐C2005 Geoinformation in Environmental Modeling 

Exercise: Photogrammetric 3D modeling of indoors 

 

Background:  This  exercise  is  integrated  in  the  international  project 

(Architectural  Democracy),  in which  the  user‐grade methods  to  use 

digital  images for automatic 3D reconstruction  is researched. None of 

the  results  (final 3D models) will be published, but we mainly collect 

user experiences. 

Description of the exercise: 

This exercise  includes  individual parts and a group part. As an output 

each student returns a report and 3D model to the Moodle. Estimates 

workload is 5 hours. 

Individual part 1: 

 Step 1. Select a room that you’ll model in 3D. This can be any room and the final result will only be 

seen by you group members and staff. The room can be from your home or any public space in which 

you have permission to take photographs. 

 Step 2. Take many images from different location of the room. Leave one wall without photographs 

(the wall in which windows are – if there are any). Notice that the quality of images and locations of 

cameras might be critical for the final results. In addition, occlusions prevent 3D measurements. If you 

have a systems camera, you might want to read further information to understand your camera and 

how to modify the image shooting parameters. The basic information can be found in Appendix 1. 

However, you can take images also with, e.g., the camera of your mobile phone, in which case there is 

usually not many possibilities to make manual adjustment of photo shooting. In any case, describe 

accurately how you took images (settings, camera type, sensor size, lens type, which principles you 

followed during the image acquisition etc.). Remember that photogrammetric measurements require 

overlap between images. I addition, take many images from various positions. 

 Step 3. Use on‐line service Autodesk 123D Catch (might require installation of client program and 

registration or Facebook account) to create automatically a 3D model from images. Don’t get upset if 

the result is not as good as you wanted.  

 Step 4. Set the scale of your model. Firstly, create two reference points in your model and then set the 

distance between them (you have to measure that distance in “real life” with, e.g., measuring tape). In 

order to be able to measure reference points, you have to click one of the images (image icons are in 

the bottom of application window). Software automatically suggests the correct location in other 

images. However, click also other images and correct if the reference point location is not correct one. 

You may also “clean your model”, if there are some parts that are obviously wrong. Just select 

unnecessary areas and delete them. 

 Step 5. Save your 3D model as .obj and return it to Moodle.  
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 Step 6. Write down in your report how you managed so far and did you get such results as you wanted 

Group part: 

 Step 7. Arrange a meeting with your group. Show your model to your group members and discuss 

about your experiences. Select the best 3D model among your group. Collect all your observations into 

one common statement. Answer, e.g., to following questions: what was successful/unsuccessful, did 

you managed to take such photographs that you wanted,  were those images optimal for 3D model 

creation, how you’d like to improve the process, etc.  If some part was not as successful as you wanted, 

try also to give reasons what happened. Write everything as a single text and distribute it among all 

group members. Each student includes this part in his/her report 

Individual part 2: 

 Step 8. Answer to following questions: 

o Was this process easy enough for anyone to make 3D models? 

o Was your 3D model good enough to be distributed through some Internet server? 

o If there existed an open access database for 3D indoor models, would you like to share (e.g. 

your room) 3D models there? 

o Would you model public indoor spaces into an open access database without any profit, if 

there was a system that makes it possible? 

o Would you make 3D models if someone is willing to pay for them? How much money you’d like 

to get before start making and distributing 3D models? 

o Would you be interested to use an application in which you could see shared 3D indoor 

models? In which purposes you’d like to use such application? 

o Can you figure out any interactive tools or features that could be nice for this kind of 

application?  

 Step 9. Give additional feedback about this exercise and estimate how much time you needed to 

complete it. Return your report to Moodle. 

Deadline of the exercise is 23.1.2015. 

 


